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Acknowledgment for Family Album Maker
The World Photo Studio that accompanies Family Album Maker on the
CD-ROM is a collection of photographs by James A. Derheim, Presiden
European Focus Photography. Palladium Interactive Inc. commissione
Jim to take photographs exclusively for the World Photo Studio. These
photographs may be used in the Family Album Maker and Ultimate Fam
Tree genealogy programs as part of the Family Journal. Palladium Inte
tive thinks you will greatly enjoy viewing these photographs and includi
them in your Family Journal.

Copyright Notice
All photographs on the World Photo Studio are © 1997 by James A. Derhe
all rights reserved worldwide.

Permission is granted to users of the Palladium Interactive Family
Album Maker and World Photo Studio to use the photographs on this C
ROM with a personal family journal prepared with the Palladium Intera
tive Ultimate Family Tree genealogy software and Family Album Maker
software. Persons interested in using these photographs or obtaining o
photographs for use in commercial publications should contact the pho
rapher directly. Some photographs in the World Photo Studio were com
missioned exclusively for Palladium Interactive and special restrictions
their use may apply.
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The photographer recommends for the best possible presentation
the photographs in a family journal that the album containing the photo
graphs be printed on a high quality laser printer or be reproduced sepa
rately in color.

When the photographs are used in a family journal the following 
credit should appear, “Photographs taken in 1996 by James A. Derheim
President, European Focus Photography, www.eurofocus.com / 
JDerheim@aol.com / 1-800-401-7802.”

A license to use specific photographs for a particular purpose, inc
ing for profit publications, may be obtained directly from European Foc
Photography. Send your publishing requirements by email or write for a
quotation to European Focus Photography, P.O. Box 550, Bountiful, UT
84011-0550.

Credits
Documentation

Una Glass, Microplus Inc.
Doug Smith, Palladium Interactive Inc.
Samantha Williams, Palladium Interactive Inc.

Editorial
Brian Mavrogeorge, Palladium Interactive Inc.

Release Notes
PC Version In order to print a Family Album Maker album you must hav
True Type fonts installed.

Mac Version The Macintosh version of Family Album Maker does not 
include the world map search mechanism.
ct
Introduction
Family Album Maker (FAM) manages photographs for use with Ultimate 
Family Tree. It allows you to:

✓ View the photos that came on your World Photo Studio CD-ROM

✓ Find World Photo Studio photos for a specific country or area

✓ Add World Photo Studio photos to your Ultimate Family Tree proje

✓ Add your own photos to your Ultimate Family Tree project

✓ Design, view, and print your own customized photograph albums
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✓ View and print photos that are already in your Ultimate Family Tree 
project

Your Ultimate Family Tree Software includes three components that all wo
together giving you the maximum ability to use photographs

• Ultimate Family Tree — Genealogy software

• World Photo Studio CD-ROM — A collection of photographs by 
European Focus Photography

• Family Album Maker — Photo management software

Photo Management
FAM photo management software is specifically designed to work with Ul
mate Family Tree and the World Photo Studio CD-ROM that came with yo
Ultimate Family Tree software package.

You can use FAM to add photos to the Media library of your Ultimate
Family Tree project. You can use photos from a variety of sources includin

• The World Photo Studio CD-ROM

• Your own photos that are on a floppy disk or your hard disk

• Your own photos that you scan using your TWAIN-compatible scanni
device

Once your photos are in your Ultimate Family Tree Media library, yo
can link them to individuals and slide shows through Ultimate Family Tree
(See Ultimate Family Tree User’s Guide for instructions on how to create 
these links.) You can also use FAM to view or print the photos in your Med
library. You may want to create your own computerized photo albums usin
FAM with the pictures in your Ultimate Family Tree Media files.

Important Concepts
FAM helps you to use your photographs with Ultimate Family Tree as wel
those that came on the World Photo Studio CD-ROM. It is important to un
stand the design concepts behind FAM in order to fully utilize its capabiliti
FAM uses three components that will give you the maximum use of photo
graphs and digital images. These components are contact sheets, the Fil
and albums.
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Contact Sheets
Photographers usually print newly developed rolls of film on contact sheets. 
Each page-sized contact sheet shows several photos, allowing the photog
pher to preview the quality of each snapshot and decide which ones shou
edited, cropped, enlarged, and saved.

FAM displays photographs on the computerized equivalent of conta
sheets. When you choose to view photos in FAM they will be displayed in
contact sheet window. The window will show one of these titles at the top

• View CD-ROM

• View Disk Directory

• View Ultimate Family Tree Library

The first three buttons on the task bar allow you to select which type
contact sheet you want to view:

Displays photos on World Photo Studio CD-ROM

Displays photos in the selected disk directory

Displays photos contained in your Ultimate Family Tree proje

Once you have displayed a contact sheet window you can use your mous
do the following:

• Select an individual photo for editing

• Select photos from the World Photo Studio CD-ROM or a disk direc-
tory, and add them to your Ultimate Family Tree project

• Drag and drop photos to a custom photo album that you create and
design

The Filter
The Filter allows you to select only certain types of photographs for displa
on a contact sheet. For example, you may be interested in viewing only th
pictures of France that are contained on the World Photo Studio CD-ROM
The Filter allows you to tell FAM to display only the pictures of France wh
you select View CD-ROM. Since there are over a thousand pictures on th
World Photo Studio CD-ROM, it would be much faster for you to find the li
ited number of photos that interest you by turning the Filter on. You can ac
the Filter by clicking either the World Map or Filter buttons on the task bar
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The World Map button allows you to select a country or state 

a world map and then display all of photos associated with that area
the World Photo Studio CD-ROM.

Note There is no World Map button on the Macintosh version of the
program. Mac users select photographs, maps, and flags using the 
function of FAM.

The Filter button allows you to do the same thing as the 

World Map button, except you define which images you want to view
using words instead of pointing to an area on a map.

Once the Filter is turned on, only those pictures meeting the search
teria you set will be displayed from the World Photo Studio CD-ROM. You
must return to the Filter window to turn the Filter off.

Albums
FAM allows you to design and print photograph albums using pictures that
stored in your Ultimate Family Tree project, the World Photo Studio CD-
ROM, or on a hard or floppy disk. Using photo albums, you can:

• Define multiple page albums

• Lay out and size your photos on each page

• Write captions for each photo

• Give the album a title and save it permanently

• View or print your albums

The printing feature will work best if you own a color printer and use
special coated paper for printing your photographs.

When you lay out an album you will use one or all of the contact she
types to view your photos, and then drag them to an album page.

Photographs in  World Photo Studio CD-ROM,  Disk File,

and  Ultimate Family Tree can be displayed in your  Album.

You can design multiple albums and give each one a name. You ma
want to create different albums based on different themes. For example, y
may want one album for ancestors and another for immediate family.
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Moving around the Main Window
You should be familiar with Windows features and terminology to take full
advantage of FAM’s capabilities. You should be familiar with:

✓ Dragging and dropping

✓ Using your mouse

✓ Repositioning a window

✓ Resizing a window

✓ Activating a window when multiple windows are visible on the scree

✓ Using the Windows clipboard

✓ Using disk drives and folders

If these concepts are unfamiliar, you should read the material below
There are also many useful books available that give easy instructions for
Windows. Additionally, there are excellent videos, tapes, and tutorials ava
able. You will get the most out of your computer and software if you fully 
understand how to use it.

Figure 1-1: Family Album Maker Main Window

Title bar Menu bar Task bar

Progress barStatus bar
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On FAM’s main window, you will see the following:

• Title Bar — The colored bar at the top of FAM’s window includes the
Ultimate Family Tree icon in the upper left corner, followed by the tit
Family Album Maker.

• Menu Bar — Click any of the menu titles to display the menu. Highligh
the item you want and click once with your left mouse button to activ
that option. Most menu bar commands can be accessed more rapid
using one of the task bar buttons which are located directly below th
menu bar.

• Task Bar — Each task button activates a commonly used feature. Fo
example, one button displays your Ultimate Family Tree Media libra
Another button lets you design and print photo albums.

• Status Bar — Check the status bar frequently while you are using FA
because it displays useful messages and prompts. The left side of t
status bar displays prompts based on the location of your cursor an
where you are in FAM. For example, it may prompt you to “Select a 
Task Button or Menu Option,” or to “Drag and Drop Images From Co
tact Sheets.”

The right side of the status bar shows the Filter status. When th
Filter is on, only a limited selection of images from the World Photo 
Studio CD-ROM will be displayed.

The central area of the status bar shows the size of the current
selected image when you are working with contact sheets and album
This feature is very useful if, for example, you want to print a photo-
graph for framing and it needs to be cropped to the size of your pict
frame.

• Progress Bar — This meter shows the percentage of a function that h
been completed.

Task Bar Buttons
Now let’s review a few task bar buttons and refer you to some new ones.

View all photos on the World Photo Studio CD-ROM

View disk directory

View Ultimate Family Tree Media library
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Add new image to Ultimate Family Tree Media library from dis

or scanner, or scan and save image to disk

Design and print custom photos albums; or print photos stored

the Ultimate Family Tree Media library, on the World Photo Studio C
ROM, or in a disk file

Find and view photos from the World Photo Studio CD-ROM 

for a specific geographic area

Find and view photos from the World Photo Studio CD-ROM 

and specify whether you want to view maps, flags, or photos for a s
cific geographic area

Display help table of contents or find help on a specific topic

Menu Bar Commands
File

• New Image — Displays New Image window. Select the appropriate to
button on the New Image window to add a new image from a disk di
tory, the World Photo Studio CD-ROM, or from a TWAIN-compatible
scanning device. You can also edit the image from this window (crop
cut, zoom, rotate, etc.) and then save the image into your Ultimate F
ily Tree project.

• Page Setup — Displays the Page Defaults dialog. Select this option t
define header, footer, and album page information. You may define t
page number format (location on the page), date format (location on
page), and font.

• Exit — Select this option to Exit from FAM.

Build

• Album — Displays the Select Album dialog. Click the name of the 
album that you want to open, and then click Proceed. If you are star
a new Album, click New. The Album menu bar option performs the 

same function as  on the task bar button.
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View

• Directory — Performs the same function as  on the toolbar.

• World Photos — Performs the same function as  on the toolbar.

• Ultimate Family Tree — Performs the same function as  on the 

toolbar.

• Filter — Performs the same function as  on the toolbar.

Utilities

• Preferences — Displays the Preferences dialog.

• Viewing Preferences — Allows you to set preferences for the way 
images are displayed in View windows. There are three different kin
of View windows in FAM: View World Photo Studio CD-ROM, View 
Directory, and View Ultimate Family Tree Media File. You can set pre
erences for each of these windows. Click Zoom to set the size of the
View window by a percentage. Click View to set the number of photo
you want displayed on each page of the View window (4, 6, 12, or 2

• Image Preferences — Choose Save As to specify the image file type yo
want to set as the default for saving your image files to disk. Choose
Prompt Before Save to have FAM prompt you to specify the image fi
type before saving. Specify the JPEG compression factor to be used
you save a files using JPG format.

• CD-ROM Location — Specify the letter for your CD-ROM drive. Once
specified, you can test to see that you specified the correct location.

• Save/Don’t Save — Either save or don’t save the preferences you hav
just specified.

Window

• Cascade — Fans the windows like a deck of cards.

• Tile Horizontally — Places windows next to each other.
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Repositioning Windows
As is the case with most Windows software, you can drag a FAM window 
around your screen by dragging the title bar. Repositioning FAM’s contac
sheet windows make dragging and dropping to Album pages much easier

Resizing Windows
You can change the height and width of a window using your mouse. Poin
the edge of a window, moving your mouse slowly until your cursor change
arrows. Hold down your left mouse button and drag the window’s edge.

Exiting Family Album Maker
In Windows 95, click the X button in the upper-right corner of the FAM win-
dow, or in Windows 3.1 or Windows 95, select File from the menu bar and
then select Exit.

Map Window

Selecting  from the task bar will display a world map. The tools on t

Map window toolbar allow you to zoom in on specific geographic regions a
display the World Photo Studio CD-ROM images associated with those ar

Using the Map Window
Use your mouse to zoom in on the area that interests you.

1. Click the zoom in tool  in the toolbar.

2. Hold down your left mouse button and drag your mouse diagonally u
a box appears. Continue dragging your mouse until you have boxed
area that you wish to magnify.

3. Release the mouse button, and the Map window will zoom in on the 
that you boxed.

You can repeat the steps above to zoom in further.

Figure 1-2: Map Window Toolbar
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4. Position the pointer over the country you want and click the right mouse 

button. Alternatively, click  in the toolbar to change your cursor to
the Pointer mode, point at the country you want, and click your left 
mouse button. The name of the country or state that you have chose
will appear in the selection box at the end of the Map window’s toolb
If you selected the wrong country, point to the country that you wish

select and click your mouse again. If you want to start over, click 
restore the world map.

5. Once you have selected the country or state that you want, click 
display the images on the World Photo Studio CD-ROM for the regio
you selected. The images will appear in the View CD-ROM window.

6. If you want to specify more details about the images to be displayed

click  on the main window’s task bar and use the Filter to make

more selections.

The Map Window Toolbar
Here is a description of the Map winodow’s toolbar icons.

Restores the full world map

Grab mode—drag map around screen to display locations that 
beyond the edge of the window

Zoom in mode

Zoom out mode

Point mode

Cancel—abandons any entries and exits from the Map window

Selection box displays the name of the country or sta
you have chosen

Filter Dialog
The Filter dialog allows you to set selection criteria for which World Photo
Studio CD-ROM images will be displayed when you choose to View World
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Photo Studio. The dialog uses standard Boolean logic. The examples liste
below will help you understand how the Filter works.

Select Where
1. To select photos using the Filter dialog, enter your first selection crit

rion. Click the down arrow to the right of box 1 to list the available 
options. The options are Type, Name, Country, State/Province, Cou
City, and Description. These options refer to the information on the 
World Photo Studio CD-ROM that is associated with each image. Ea
image has a type (for example, map or photo), a name (for example, 
Union Jack), the country to which the image is related (for example, 
United Kingdom), and for some images, the state, county, and city to
which the image is related.

2. Enter the logical operator. Click the down arrow to the right of box 2 
a list of options. Choose Contains to include photos that contain the
terion you specify. Choose Matches to include photos that match exa
the criterion you specify.

3. Enter the selection criterion in box 3. For example, if you want to sel
maps, you would enter Map. You can also use standard Windows wild 
card symbols (* and ?). Pay attention to the exact spelling and word
of the selection criteria you use. If you set criteria and are unable to 
what you are looking for, try again using different wording. For exam
ple, if you enter Great Britain as your criterion, no images will be dis-
played, but using United Kingdom will result in matches. Experiment 
with various search criteria until you find what you are looking for.

4. If you are going to enter additional selection criteria into the next row
boxes, click the AND/OR button. This button toggles the logical rela-
tionship between your first selection criterion and your second.

Figure 1-3: Filter Dialog

Box 3Box 2Box 1
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Sort By
Choose the order in which you want the images displayed. For example, 
might want them sorted first by country and then by city.

Data Grid
Below the Sort option is a grid that lists all of the information contained in 
World Photo Studio database about the currently selected (filtered) image
The information is listed in the sort order that you have selected.

At the top are the column titles Type, Name, Country, State/Province
County, City, and Description. Each row in the grid contains information as
ciated with one image. For example, the third row in the example grid abo
contains information associated with the image of United Kingdom’s flag. Y
can change the width of each field displayed by positioning your pointer o
one of the vertical lines between the columns until you see a double arrow. 
the line to change the width of the column.

Filter Criteria Examples

Box 1 Box 2 Box 3
AND/OR 
toggle

Result

Country Contains France  Displays all photos, maps, and flags where the 
country contains the word France

Country Contains France  AND Displays all maps where the country contains 
the word FranceType Matches Map

Country Contains G AND Displays all photos for countries which include 
the letter G. Photos for Germany, Greece, and 
so on will be displayedType Matches Photo

Country Contains France OR
Displays all photos where the country contains 
the words France or GermanyCountry Contains Germany AND

Type Matches Photo

Figure 1-4: Example Data Grid
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If you want to display the image that is associated with one of the ro
double-click that row with the left mouse button. The item will be displayed
an Edit Image window, and you can edit the image or save it to your Ultim
Family Tree Media library.

Activate Your Filter Selections
After filling in all of your selections (Filter criteria, sort order, etc.) in the Fi
ter dialog, click the appropriate button to activate the Filter:

• Filter — turns the Filter on using the criteria shown in the dialog

• Show All — turns the Filter off, thereby displaying all images

• View — displays the filtered images

• Close — closes the Filter dialog, leaving current settings active

Note Once the Filter has been turned on it will remain active until y
turn it off by clicking Show All.

Note If some of the World Photo Studio images are not being dis-
played, always check to see how you have set the Filter.

Using the World Photo Studio CD-ROM
The World Photo Studio CD-ROM includes several hundred pictures from
various countries around the world. It also includes maps and flags for mo
countries. You may want to use some of these pictures, flags, or maps in 
Ultimate Family Tree project to enhance background information about yo
family’s history.

You can access the pictures which interest you the most by turning 
FAM’s Filter. This will allow you to view only those photos which relate to 
particular country, or allow you to select, for example, only flags for viewin
Turning on the Filter will allow images on the World Photo Studio CD-ROM
to display much faster, because you will be viewing a limited selection of 
images.

View Photos of a Specific Country
To view photos of a specific country:

1. Put the World Photo Studio CD-ROM in your computer’s CD-ROM 
drive.
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2. Click the  icon on the task bar.

3. Use the Map window to zoom in on the country that interests you.

4. Use the navigation bar  window to page forward and bac
ward through the images.

Specify in More Detail the Maps, Flags, and Photos You Want 
to Display
To specify in detail the maps, flags, and photos you want to display:

1. Put the World Photo Studio CD-ROM in your computer’s CD-ROM 
drive.

2. Click the Filter icon  on the task bar.

3. Enter your Filter selections onto the Filter dialog.

4. Use the navigation bar  window to page forward and bac
ward through the images.

View All of the Photos and Maps on Your World Photo Studio 
CD-ROM
To view all of the photos, flags and maps that came on your World Photo 
dio CD-ROM:

1. Put the World Photo Studio CD-ROM in your computer’s CD-ROM 
drive.

2. Click the  icon on the task bar.

3. Use the navigation bar  window to page forward and bac
ward through the images.

Using Your Photographs
How should you get your photographs into FAM? There are several ways

• Use a TWAIN-compatible scanner
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• Have your existing photos scanned at a print shop or computer store

• Have your new rolls of film developed by a company that will digitize
your photos and put them on diskettes

• Use a digital camera

Adding Images to the Media Library
You may want to permanently add a picture from the World Photo CD-RO
to your Ultimate Family Tree Media library. To do so, view the World Photo
CD-ROM, select the image you want, and then save it to your Ultimate Fam
Tree Media library.

1. Display the World Photo Studio CD-ROM by clicking the appropriate
task bar button:

To display all images on the CD-ROM

To display images for a specific geographic area

To display images using detailed selection criteria

2. Use  on the View window to page forward and backward
through the images.

3. Select the image you want to add to your Ultimate Family Tree Med
library by double-clicking the image. The image will be displayed in t
Image window.

4. Edit the image, if desired, using the Image window’s edit features.

5. Click the Image window to open the Save to Ultimate Family Tree d
log.

6. Enter any additional information into the dialog that you want saved
your Ultimate Family Tree Media library.

7. Click the Save to Ultimate Family Tree dialog to save to your Ultima
Family Tree Media file.
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Using the Image Window
The Image window allows you to

✓ Display a single image

✓ Scan an image

✓ Edit an image

✓ Save an image to the Ultimate Family Tree Media library or a disk fil

The Image window can display images from

• The World Photo Studio CD-ROM

• A disk directory

• The Ultimate Family Tree Media library

• A TWAIN-compatible scanning device

You can load an item into the Image window in several ways.

• Double-click a single image while in any of the View windows (View 
World Photo Studio, View Directory, View Ultimate Family Tree). Tha
image will appear in the Image window.

• Select View Directory and then Double-click on a file name in the Ge
Directory dialog. That image will then appear in the Image window o
your screen.

• Select the Filter and double-click an item (a single row) in the data g
of the Filter dialog. That image, from the World Photo Studio CD-ROM
will appear in the Image window.

You can also select the  icon (or the New Image option from th

File menu) and a blank Image window will appear. From there you can cho
to scan an image and save it to your Ultimate Family Tree Media library o
save it to a disk file.
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The Image Window Menu Bar
The Image window menu bar provides additional editing and saving featu

• File — Saves images to disk. Choose Save or Save As from the File
menu to save an image to a disk file rather than into your Ultimate F
ily Tree Media library. You can save scanned or edited images. Notic
that FAM automatically assigns the appropriate three letter extensio
the end of the file name (e.g., *.bmp). Do not change the extension, 
because it indicates the format of the image to FAM and other softw
FAM supports several types of image file formats.

• Edit — Performs the clipboard functions (copy, paste, cut) available 
the floating toolbar.

• Image — Makes various adjustments to the current image, including
Brightness, Gamma, Mirror, Reduce Colors, Rotate, Dither Method, a
Invert.

• Scan — Select Source allows you to select a scanner if you have mo
than one from which to choose. Acquire activates you scanner (sam

).

Using the Image Editor
The image title appears on the upper left corner of the Image window. In t
example below the title is alyssa6.bmp. The appearance of the title will vary 
depending on the source of the image.

• If the image is from the World Photo Studio CD-ROM, the filename, 
drive, and directory path will appear.

• If the image is from a disk directory only the file name will appear.

• If the image is in the Ultimate Family Tree Media library, the title 
Library Image will be displayed followed by the name of that image.

• If no image has been selected the title area will display New Image.

Figure 1-5: Image Window Toolbar
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The icons on the toolbar include:

Save to Ultimate Family Tree Media library

Open Image — Retrieves an image from a disk directory. Select 
this icon only if you have not already loaded an image into the Imag
window.

Scan — Activates your TWAIN-compatible scanning device. 
Selecting this icon will open your scanner dialog, which will prompt 
you to put a photo or negative in your scanner. The image you are s
ning will appear in FAM’s Image window after your scanner finishes.
You can then edit and save the image you scanned.

Print — Prints the current image. Click this icon to open a dialo
with the following options:

• Scale Options — Choose Don’t to print the image at the size shown in
the Image Size box, Fit to Page to size the image to best fit on a sin
page, or Scale to increase or decrease the size of the image by the 
centage you specify.

• Paper Size — Indicates the size of the paper you are using. Click the
Setup Printer button and select the appropriate options.

• Image Size — Indicates the size the image will be when it is printed

• OK — Prints using the options selected

• Cancel — Abandons printing

• Set Up Printer — Activates the printer dialog. You can select varying 
options here depending on the type of printer connected.

Copy — Copies the current image to the Windows Clipboard. Yo
can then paste the image into  another application (word processor,
image editor, etc.) that will accept data from the Clipboard.

Paste — Pastes an image from the Windows clipboard into the 
Image window. You can paste images that you copies from other ap
cations such as other photo or image editors.

Zoom Marked — Selects an area of the displayed image and zoo
ing in on that area. This option crops, or cuts, out the selected area. Yo
may want to use this option to eliminate parts of a picture and then s
the edited version of that picture. To use this feature, position your 
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pointer at the upper left corner of the area you want to crop, hold do
your left mouse button and drag diagonally until the box has outlined
the area that you want to keep. Lift your finger off the mouse button a

the box will remain. Click  to crop the image.
If you do not like the position of the box after it is set, you can 

move the mouse pointer to a new spot and repeat the process. The 
nal box will disappear and a new one will be drawn.

Zoom Out — Makes the image shown in the Image window smal

Zoom In — Makes the image shown in the Image window larger

Undo/Restore Original — Restores the image to the way it was 
before you began editing

Cancel — Abandons the image on the screen without saving an
exit the Image window

Scanning Photographs into a Disk File
To add photos to a disk file using your TWAIN-compatible scanner:

1. Click  on the task bar and the Image window will appear. New 

Image will be displayed in the upper left corner of the window.

2. Click  on the Image window and a dialog specific to your scanne
will be displayed. Follow the directions for your scanner (see the doc
mentation that came with your scanner).

3. Once the scanner has finished processing, select the Save option in
scanner software’s dialog. Your scan will appear in FAM’s Image win
dow.

4. Edit the image, if desired, using the Image window’s edit features.

5. Select Save As from the File menu. The Save As dialog will appear.

6. Indicate the disk drive and folder where you want to save, and the fi
name you want to give your scan. You must also designate the imag
file type. (It is easiest to use the default file type that FAM enters for
you.)

7. Click OK to save your photo.
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Image File Formats

 

FAM supports the following image file formats:

 

Photo Albums

 

FAM allows you to design custom photo Albums using your own photos or 
those supplied with FAM. You can:

 

✓

 

Design a multi-page photo Album

 

✓

 

Store multiple Albums, each having a unique name

 

✓

 

View, edit, and print your Albums

 

✓

 

Use the same picture in multiple Albums

 

✓

 

Define the details of each page in your Album

 

✓

 

Drag and drop pictures onto each page of your Album from your Ulti-
mate Family Tree Media library, a disk directory, and the World Photo 
Studio CD-ROM

 

✓

 

Position and resize each of your pictures

 

✓

 

Select a background color or pattern for each page

 

✓

 

Select portrait or landscape mode for each page

 

✓

 

Add captions or descriptive text in any font and color

 

Image type File extension Maximum colors

 

BMP .BMP 16.7 million

DCX DCX 16.7 million

IMG IMG 16

JPG JPG 16.7 million

Kodak Photo CD (read only) 16.7 million

PCX PCX 16.7 million

Targa TGA 16.7 million

TIFF TIF 16.7 million

GIF (read only) GIF 256
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Creating an Album
To create a custom photo Album:

1. Select  from the task bar to open the Album window. The word

Untitled appears in the upper left corner of the Album window. This 
indicates that you have an empty Album page in front of you on whic
you can begin laying out your Album.

2. Click one or all of the View task bar buttons to display each of the Vi
windows. You can display all three windows simultaneously. You onl
need display a View window for the location that includes the photos
you plan to use in your Album. For example, if you plan to use imag
that are stored in your Ultimate Family Tree Media library, then displ
the Ultimate Family Tree Media Library View window only. Your 
choices include:

View image on the World Photo Studio CD-ROM

View images in a disk directory

View images in your Ultimate Family Tree Media library

3. Reposition the View windows, the Album window, and the floating to
bar until you find them easy to work with. You may want to put the 
Album window on the right side of your screen and the floating toolb
next to it. Then position the View window(s) on the left side.

4. Page through your View window(s) to locate an image you want to p
onto the first page of your Album.

5. Position your pointer over the image you want and hold down your l
mouse button. Drag and drop the image onto the Album page that is
showing in the Album window. The image will be displayed on the 
Album window as well as the View window.

6. Reposition and resize each image in the Album window as desired.

7. Add text (captions or descriptions) to the page, using the Floating to
bar.

8. Repeat steps 5–7 to put any additional images on the page.
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9. Click  to save the page. A dialog will appear, allowing you to nam
the Album.

10. Use  to go to the next page in your Album, add more pho
to your Album, and save each page as in step 9.

11. When you have completed your Album, print it by clicking , or vie
and print your Album later.

Viewing and Editing an Album
To view or edit an existing Album:

1. Select  from the task bar and the Album window will open.

2. Click  and the Select Album dialog will open.

3. Highlight the Album you want to view from the list and click Proceed
The Album window will display the first page of the Album you 
selected.

4. Use  on the Album toolbar to page forward and backwar
through your Album.

5. Edit images in your Album, add or delete pages, or print your Album

Printing an Album
To print an Album:

1. Click  on the task bar.

2. Click  on the Album window to open the Select Album dialog.

3. Double-click the name of the Album you want to open.

4. Click  on the Album window. The Print dialog will be displayed.

5. After setting the options you want in the Print dialog, click OK to prin
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Printing a Photo
You can print your photos from several locations within FAM.

• Print a contact sheet from the View window

• Print a single image from the Image window

• Print single or multiple images using the Album window

• Print an entire Album or a single page of an Album from the Album 
window

Printing a Contact Sheet from a View window
1. Choose the View window that you want to use:

World Photo Studio CD-ROM

Disk directory

Ultimate Family Tree Media library

2. Use  on the View window to page through the images.

3. Click  on the View window to display the print dialog.

4. Click OK to print the current page.

Printing a Single Photo—Method 1
1. Choose the View window that you want to use:

World Photo Studio CD-ROM

Disk directory

Ultimate Family Tree Media library

2. Use  on the View window to page through the images.
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3. Double-click the image you want to print to load it into the Image 
window.

4. Click  on the Image window.

5. Select the options you want in the Print Image dialog.

6. Click OK to print.

Printing a Single Photo—Method 2
You can use the Album window to print single or multiple images without 
actually creating and saving an Album. The Album Print feature has the ad
advantage of allowing custom text boxes.

1. Choose the View window that you want to use:

World Photo Studio CD-ROM

Disk directory

Ultimate Family Tree Media library

2. Click  to display the Album window. The Album window will 

show Untitled in the upper left corner.

3. Reposition the View window, the Album window, and the Album float
ing toolbar so that they are lined up next to each other. (See “Movin
around the Main Window” on page 6 for more information on using 
your mouse to reposition windows.)

4. Use  to page forward and back through the View window

5. Drag and drop the images you want to print from the View window to
the Album window.

6. Resize and reposition the images on the Album window page. Add t
if desired, using the floating toolbar.

7. Click  and select the options you want on the Print dialog.

8. Click OK to print the page.
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Int roduction
Welcome to the Social Security Death Records CD. This database contains the
Death Master File (DMF) from the Social Security Administration (SSA), cur-
rent through August 1996. Unlike similar programs at this time, however, the 
CD also contains an automatic letter generator to request a copy of an individ-
ual’s application for a Social Security card (Form SS-5) and an electronic ver-
sion of Form SS-5. See the Help menu option Value of Ordering the SS-5 for 
additional research tips to help in your research efforts using Social Security 
records.

This Social Security Death Index database is created from SSA payme
records. The DMF includes the following information on each decedent, if the
information is available to the SSA: Social Security number, name, date of 
birth, date of death, state or country of residence where number was issu
(Feb 1988 and prior), Zip code of last residence, and Zip code of lump su
payment. Primarily, the index covers deaths since 1962, though it does includ
some earlier records.

The SSA does not have a death record for all persons; also, an estima
three percent of the records entered on the DMF are incorrect. Therefore, the 
SSA cannot guarantee the veracity or accuracy of the file. The absence of a 
particular person is not proof this person is alive. Also, some individuals might 
have had more than one Social Security number, and more than one person 
might have used the same Social Security number. Some Zip codes may also 
have changed, making the corresponding localities incorrect.
2 7
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If you cannot find a deceased individual’s name in the index, consider
following possibilities:

• The person might not have received a Social Security number.

• The information might have been reported incorrectly.

• The SSA might not have been notified of the person’s death.

• The person might have changed his or her given name or surname.

• The person might have used a different spelling on his or her name.

• The person might have died before the SSA put its records on comp

If for any reason the SSA has incorrectly listed you as deceased on
Death Records CD, please contact your local Social Security office (with 
proof) to have your status corrected. You may also contact them for furthe
advice if you need help.

There is virtually no difference between the Mac and Windows versio
of this program. The following instructions cover both versions.

Using the Program
The Social Security Death Records CD uses a powerful engine to quickly
search the nearly 54 million records on the CD. After installing the progra
click the text box where you will type your first search criterion. Type the te
for your search and press Tab to move to the next field, or Shift-Tab to mov
the previous field. You can also click the desired field.

For the fastest searches, supply as much information as possible w
searching on surname, given name, state, year of birth, or year of death. W
using the asterisk (*) as a wildcard in a search, include at least the first tw
characters if possible (e.g., Gr* ). This narrows the search, allowing faster 
response time and requiring less disk space for temporary files.

Use the Social Security Death Records CDs by placing the proper d
(surnames beginning with A–K are on Disk 2, and L–Z are on Disk 3) in th
CD-ROM drive, then double-clicking the program icon.

As an example, to locate the SSN of Marilyn Carter, type Carter in the 
Surname field. (Note that the DMF usually lists married name as the surna
unless the person was single or had legally changed his or her surname.)
further refine your search to find Marilyn Carter born in 1924, type Marilyn in 
the Given field and 1924 in the Year Born field. Click the Search button. The
CD will bring up a list box with the names meeting your search criteria, or
report that no matches were found.
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Figure 2-1: Windows Query for Social Security Death Index

Figure 2-2: Macintosh Query for Social Security Death Index
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Once the results of your search are on screen, note that the names 
first sorted alphabetically, then generally by SSN. The program also lists a
persons with no issuing state information first; therefore, you may move p
the first individuals before encountering an abbreviation for an issuing sta

Note In the state field, RR stands for railroad record. The notation 
1000 means that this was the information received from the SSA in e
tronic format, though it is obviously incorrect.

When the search results are displayed, click the Next Page or Previ
Page buttons to move through the list. If the results are extensive (for exam
300 possible matches), try including more specific search criteria to narro
the search.

The CD will also print the information currently on screen. To print th
list, choose Print List from the File menu. Select the lines of text items to 
printed; the program will print the corresponding name, SSN, issuing stat
date of birth, date of death, state where died, and Zip codes of last residence 
and payment. To print the list to file so that it can be edited and saved, select
Print to File option.

You can bring up the decedent’s Zip Code information by clicking on
name. The Zip code information is the Zip code where SSI benefits were 
mailed.

Letter Generator
When you have found the name (or group of names) of interest, streamlin
your research efforts by using the built-in letter generator and browse list 
capabilities, described below.

The Social Security Death Records CD automatically generates a 
request for a copy of a deceased person’s Social Security card applicatio
(Form SS-5). To print the letter, highlight the desired individual’s name an
select Print Letter from the File menu. You will be asked to supply the nam
address, and telephone number for the return address (once you enter th
information it will remain the default until changed).

Note To print the letter to a file so that it can be edited and saved, 
select the Print to File option in the Print dialog.

Note For additional input on ordering a copy of an individual’s appl
cation for research purposes, see the File menu option The Value of
Ordering the SS-5.



EXITING  THE PROGRAM 3 1

ve 
s) 
Exiting the Program
Clear the data fields at any time by clicking the Clear button. Once you ha
completed your search and are ready to exit, click the Exit button (Window
or the Quit button (Macintosh) to leave the program. Or, if desired, select 
these options from the File menu.

Figure 2-3: Windows Letter Generator

Figure 2-4: Macintosh Letter Generator
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Using the Program
The Gazetteer CD uses a powerful search engine to quickly search index
pages in the following gazetteers:

• A New Gazetteer of the United States of America, by William Darby and 
Theodore Dwight, Jr. Published by Edward Hopkins, 1833, Hartford
CT. Copyright 1996 GenRef, Inc. Over 600 pages.

• A Gazetteer of the United States of America, by John Hayward. Pub-
lished by Case, Tiffany, and Company, 1853, Hartford, CT. Copyrigh
1996 GenRef, Inc. Over 800 pages.

Follow these instructions to search the Gazetter CD for locations:

1. Click the first Word Phrase text box. Type the desired search text (fo
example, Columbus), then tab to the next Word/Phrase text box and ty
additional search criteria (for example, Ohio). To return to a previous 
field, press Shift-Tab.

Note For the fastest searches, supply information in both text boxe
When using the asterisk (*) as a wildcard in a search, include at leas
first two characters if possible (e.g., Gr* ). This narrows the search, giv-
ing a faster response. Less disk space is also required for temporar
files.

2. Next, from the Options drop-down list, select All Early American to 
have the CD search both the 1833 and 1853 gazetteers, 1833 to hav
CD search the 1833 edition only, or 1853 to have the CD search the
3 3
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1853 edition only. Select 1833 Table of Contents for a quick overview
the items included in the 1833 gazetteer, or 1853 Table of Contents
glance through the items in the 1853 gazetteer.

3. Click the Search button. The CD will bring up a list box with the nam
meeting your search criteria, or report that no matches were found. 
Click the Next Page or Previous Page buttons to move through list.

4. As noted at the bottom of the input screen, double-click the desired
entry to view the page image or receive additional information. Click
the printer icon to print the page, or select the Return to Main Scree
Previous Page, or Next Page options.

5. After you have viewed the desired information and returned to the m
screen, further streamline your research efforts by using the built-in 
Print List capability. To print the current list of information on-screen
click on the File menu and select Print List. Select the lines of text ite
to be printed; the program will then print the corresponding informatio
To print the list to file so that it can be edited or saved, select the Prin
File option.

Figure 3-1: Gazetteer Location Search Screen
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Exiting the Program
Clear the data fields at any time by clicking with the mouse on the Clear b
ton. Once you have completed your search and are ready to exit, click on
Exit button to leave the program. Or, if desired, select these options from 
File menu.
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Record Requester automates the process of requesting certified copies o
birth, death, marriage, or divorce certificates. Please note, however, that y
must meet certain requirements to be eligible (see “Who May Receive Co
ies,” below). Once you’re sure you qualify, follow the procedure below to 
obtain information from state, county, or country offices. You may also brow
a log of letters you previously generated, or update your own personal 
information.

Note Hotkeys are provided in selected fields to help streamline the
request process. To access a field through its hotkey, press Alt and 
underlined letter in the field name.

Who May Receive Copies
Vital records are not available to the general public. To receive a copy, yo
must be:

• The person named on the record

• A parent or a member of the immediate family

• A legal representative or anyone who can prove a direct interest, suc
a named beneficiary or someone who jointly owns property with the
person whose record is requested

A record will not be released to anyone with an adversarial interest in
the record. Proof of legal representation, direct interest, or written authori
tion is required. A personal identification number must be furnished befor
3 7
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copies will be made available. In most cases this number is a driver’s lice
number (send photocopy of license only) or social security number.

Using Records Requester
1. Click the Record Requester icon. The Main Menu appears.

2. Click the Edit/Update User Information button.

Figure 4-1: Main Menu Window

Figure 4-2: User Information Window
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3. The User Information screen will appear, prompting you for the full 
name, address, daytime phone number, and driver’s license numbe
be printed as the return address on each letter you create. All of this
information is essential, so be sure to complete it before printing any
ters. This information will remain the default until you change it. To ex
the User Information screen, click the Main Menu button.

4. Click the State, National, or County button on the Main Menu. When
you use the State or County option, you may request a specific docu
ment. Because country requirements vary widely, selecting the Cou
option will only allow you to generate a letter requesting more inform
tion. If you are requesting a State or County document your choices 
be Birth, Death, Marriage, and Divorce records.

5. In the pull down text fields, choose the desired locality. Information 
about that locality will appear in the window (e.g., where your reque
will be sent, what the current fees for the type of record you have 
requested are, the processing time to expect, comments about wha
is available, and any specific payment information).

6. The fee for additional copies is for copies requested at the same time. 
Credit card and rush fees are in addition to the charge for copies. SASE 
required? indicates whether a self-addressed, stamped envelope sho
be submitted with your request.

Figure 4-3: Records Requester State Document Screen
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7. If the State office does not have what you need, the Comments field
often direct you to the correct county office. Be aware that some cou
offices keep vital records while others do not. Call county offices first
check on the best way to get the information you need.

8. Click on the Request button to enter more details about the informa
you want. The Request window will appear (Figure 4-4).

9. Fill in the blanks. When entering parents’ names, be sure to supply 
mother’s maiden name in parentheses. If you’re entering a date, inc
a leading zero on single-digit months (for example, 09 for September).

10. Enter payment method and payment data as prompted, then click P
Form to print the request letter without saving it, Save Request to sa
the details in a log for future reference, New Request to return to the
previous screen, or Main Menu to return to the Main Menu.

11. To review or edit details about the requests you have sent out, click
Browse Requests button on the Main Menu. The Browse Requests 
dow appears, providing a quick list of names, locations, document 
types, requested dates, and receipt dates (can be edited). Sort the l
clicking on the radio button that corresponds to your preference.

Figure 4-4: Request Window
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12. To edit the receipt date, highlight a request and click Edit. A screen 
appears giving you detailed information about your request and the 
opportunity to enter a received date. Click Done to return to the log.

13. To delete a request from the log, highlight it and click Delete. To rep
an original request letter, highlight the individual in the log and click 
Print. To return to the Main Menu, click the Main Menu button.

Figure 4-5: Browse Requests Window
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